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Maintaining your lists

TradingExpert Pro provides a number of functions for maintaining
the data contained in your Group/Sector List and all other lists that
you have created.  This section lists the data maintenance functions
for lists and provides instructions for using each function.

Delete a list

å Follow these steps to delete a list:

1. Open the Data Manager application.

2. From the Selected List text box located on the toolbar, select the list
that you want to delete.  The selected list will be displayed in the
List window.

3. Click the List command on the menu bar.

4. Choose Delete on the drop-down menu. The Delete List dialog box
appears with the name of the selected list displayed.

5. Choose Yes to delete the list or No to cancel.

Rename a list

This function is used when you want to change the name of an
existing list..

å To rename a list:

1. Open the Data Manager application.

2. From the Selected List text box located on the toolbar, select the list
that you want to rename. The selected list will be displayed in the
List window.

3. Click the List command on the menu bar.

4. Choose Rename on the drop-down menu. The Rename List dialog
box appears with the name of the selected list in the text box.

5. Type a new name in the text box.

6. Choose OK to execute the change.

Remove ticker from a list

When a ticker is removed from a list, all tickers underlying that ticker
are also removed.  For example, if you remove an industry group, all
stocks in that group are also removed from the list.

 Rename List dialog box

Delete List dialog box
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å To remove a ticker:

1. Open the Data Manager application.

2. From the Selected List text box located on the toolbar, select the list
that contains the ticker you want to delete.  The selected list will be
displayed in the List window.

3. Expand the list, then select the ticker to remove by clicking on its
name.

4. Click the Remove from List button on the toolbar (or select the
Remove Ticker command from the List sub-menu).  The Remove
Ticker from List dialog box appears.

5. Choose Yes to delete the ticker (and all underlying tickers) from the
list, or No to cancel.

Insert tickers into a list

The Insert ticker(s) function is used to insert one or more tickers
into a list.

å To insert tickers:

1. Open the Data Manager application.

2. From the Selected List text box located on the toolbar, select the list
that you want to add to.  The selected list will be displayed in the
List window.

3. Highlight, by clicking, the insertion point in the list.  The insertion
point can be a sector, a group, or the list itself.

4. In the Master Ticker List, select the ticker (or tickers) that you want
to insert into the displayed list.

� To select a single ticker, click on the ticker name to
highlight it.

� To select multiple tickers, hold down the Ctrl key while
selecting tickers.

5. Click List on the menu bar.

6. Choose Insert Ticker(s) on the drop-down menu.

 Remove Ticker from List dialog box
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Warning
 Do not remove inactive
tickers from your Group/
Sector List.  These tickers
will become active if their
symbols are added to your
Master Ticker List.

Remove inactive tickers

When tickers are inactive, they appear in gray type in a list.  This
function is used to remove the inactive tickers.

å To remove inactive tickers:.

1. Open the Data Manager application.

2. From the Selected List text box located on the toolbar, select the list
that contains inactive tickers.  The selected list will be displayed in
the List window.

3. Click the List command on the menu bar.

4. Choose Remove inactive tickers.  A window appears asking if you
want to remove all inactive tickers in the selected list.  Choose Yes.

 Remove inactive tickers window

5. A second window appears verifying that you want to remove the
inactive tickers.

6. Choose Yes again, or No to cancel.

Converting a list to decimal format

You can convert your AIQ data files from fraction to decimal format
with this special Utilities menu function.  The tickers you are
converting must be in an AIQ list.

å To convert a list to decimal format:

1. Open the Data Manager application and, from the Utilities menu,
choose Convert List to Decimal.

2. From the list box at the top of the Decimal Conversion Utility
screen, select the list you want to convert.

3. Select the option with the number of decimal places you prefer.

4. Click the Start Conversion button.  Messages pertaining to the
conversion will appear in the Results box.

5. When the conversion is completed, click Done.

 Decimal Conversion Utility screen
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Find & Create

If an AIQ list contains tickers that are not in your Master Ticker list,
you can use this utility to find all missing tickers in the list and to
quickly create new Master Ticker List entries for them.  Find &
Create retrieves the necessary ticker information (Description, Start
Date, and Market) from either the AIQ Historical Data CD or from
myTrack Online via the internet, then creates data files for those
tickers for which information is found.

å To open Find & Create:

1. Open Data Manager.  In the List section of the main window,
display the list you want to examine for missing tickers.

2. Select Find & Create from the List menu.

3. The Missing tickers window will appear.  This window shows all
tickers that are missing from the selected list.

4. Your next step is to retrieve the data necessary to create a new data
file for each of the missing tickers.  Continue below.

å To retrieve the missing tickers:

1. Select one of the two Lookup via command buttons. This choice
determines where the function looks for the information that it uses
to set up ticker data files. Choosing either one of these commands
initiates the data retrieval process.  The choices are:

� Historical CD: Data is copied directly from the AIQ
Historical Data CD.

� myTrack Online: After the online data base is accessed,
data is downloaded via the internet.

Missing tickers dialog box
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2. If you choose myTrack Online, use the list box at the top right to
specify the maximum number of years of historical price/volume
data that you want to retrieve for each ticker.

3. When data retrieval is completed, the Missing tickers window will
display a file icon next to those tickers for which information was
found.  Also, information will be shown in the Description, Start
Date, and Mkt data fields.  Any tickers not found in the selected
data base will display an X in place of a file icon.

4. Your next step is to retrieve the data necessary to create a new data
file for each of the missing tickers.  Continue below.

å To create data files for the missing tickers:

1. To create data (.dta) files for each ticker found in the selected
database, click the Make DTA Files command button.  Files will be
created for all found tickers and the tickers will be inserted  into
your Master Ticker List.

2. To exit the Missing tickers window, click Done.

Missing tickers dialog box
after lookup completed
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Advanced List Edit

This utility is used to import/export lists and to perform various
editing functions on AIQ list files.

� You can open multiple lists and drag/drop or cut/paste between the
lists.

� You can import CSV list files from Excel.

� You can export list files to CSV format, which allows you open and
work with them in Excel.

å To access Advanced List Edit:

� Select Advanced List Edit from the List menu.

-or-

� Click the Advanced List Edit toolbar button.

The Advanced List Edit window appears.  The large empty window is
used for displaying one or more lists.

Advanced List Edit window
with two lists displayed
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Opening lists in Advanced List Edit

å To open an existing AIQ list file:

1. From the File menu, select Open.

-or-

Click the Open toolbar button.

2. The standard Windows Open dialog box will appear.

3. Go to your winTes32 folder and select the list file (.lis) that you
want to open.

4. Click the Open command button.

5. The list will appear in the Advanced List Edit window.  Lists are
displayed in exactly the same format as in the List section of the
main Data Manager window.

å To open multiple lists:

1. Open each list using the same procedure as above.  You can only
open one list at a time.  As each list is opened, it is displayed in a
separate panel within the Advanced List Edit window.

2. Use the Tile and Cascade commands on the Window sub-menu to
arrange panels in the configuration you prefer.  You can also move
and resize individual list windows with your mouse using standard
Windows procedures.

Creating a list in Advanced List Edit

å To create a new list:

1. From the File menu select New.

-or-

Click the New toolbar button.

2. In the List Name dialog box, type a name for the new list

3. Click OK to open a new panel which contains the new list.  At this
point, the new list consists only of the list name.

Moving, copying tickers from one list to another

å To move a ticker from one list (source list) to second list
(target list) using Drag and Drop with mouse:

1. In source list, find ticker you want to move to target list.



120    AIQ TradingExpert Pro Reference Manual

2. Select ticker and, while holding down the left mouse button, move
the mouse to the location in the target list where you want the ticker
to appear.

3. When you release the button, the ticker will appear in target list and
is removed from source list.

å To move a ticker from one list (source list) to second list
(target list) using Cut and Paste:

1. In source list, find ticker you want to move to target list and select.

2. Choose Cut from Edit menu.

3. In target list, select list or ticker where you want ticker to be
inserted.

4. Choose Paste from Edit menu. The ticker will appear in target list
and is removed from source list.

å To copy a ticker from one list (source list) to second list
(target list):

1. In source list, find ticker you want to copy to target list and select.

2. Choose Copy from the Edit menu.

3. In target list, select list or ticker where you want ticker to be
inserted.

4. Choose Paste from the Edit menu. The ticker will appear in target
list and remains in source list.

å To remove a ticker from a list:

1. Find and select ticker.

2. Select Delete from the Edit menu and click Yes to confirm the
delete.

Importing/Exporting CSV list fi les

A properly formatted CSV file can be imported by Advanced List
Edit.  Once in Advance List Edit, the file can be saved in the AIQ list
file format.

The CSV (Comma delimited) file format is one of the formats in
which an Excel worksheet may be saved. When an Excel worksheet is
saved in the CSV file format, the text and values displayed in cells of
the worksheet are saved.  All rows and all characters in each cell are
saved. Columns of data are separated by commas, and each row of
data ends in a carriage return.

Note
The Undo button on the
toolbar removes last edit
(only one level).
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Most screening software will allow you to export the results of a
screen in the form of a CSV formatted file.  If necessary, you can then
use Excel to make modifications to the file so that it can be read by
Advanced List Edit.

The CSV format is suitable for multi-level structured lists as well as
simple one level (flat) lists.  Creating a multi-level list, such as a
sector/group/stock structured list, will require some manipulation in
Excel and is beyond the scope of this documentation.

Importing CSV List Files

å To import a CSV file:

1. Open Advanced List Edit and click the New toolbar button.

2. In the List Name dialog box, type a name for the new list (this is the
list file that will contain the imported list file).  Click OK.

3. Choose Import from the File menu. (You need to have a file open
before this option shows on the menu).

4. Use the Import From dialog box to locate the CSV file you want to
import.  When you have the file selected, click Open.

5.  When the processing of the imported CSV file is complete, the
imported list will appear in the Advanced List Edit window under
the name of the list created in step 2.

Import From dialog box

Note
The Import and Export
commands found on the List
submenu may also be used to
import/export CSV list files
to and from Data Manager.
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Export To dialog box

Exporting a list as a CSV file

å To export a CSV file:

1. Open Advanced List Edit and click the Open toolbar button. The
standard Windows Open dialog box will appear.

2. Use the Open dialog box to find and select the AIQ list (.lis) file
that you want to export.

3. Click the Open command button.  The list will appear in the
window.

4. Choose Export from the File menu. (You need to have a file open
before this option shows on the menu).

5. Use the Export To dialog box to specify a location for the exported
CSV file.  The Save as type list box should display Comma
Delimited (*.csv).

6. Click the Save command button to initiate the exporting process.
When complete, the exported list file will be saved in the folder
specified in step 5.
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Advanced Search

This special List function examines the active list and does any of the
following:

� Finds a specific ticker in the list.

� Creates a list of all tickers that are missing from the Master Ticker
List

� Creates a list of all tickers that are designated inactive.

å To open Advanced Search:

1. Open Data Manager.  In the List section of the main window,
display the list you want to examine for missing tickers, etc.

2. Select Advanced Search from the List menu.

3. The Find dialog box will appear.  This dialog box provides three
options:

� Ticker

� Missing Tickers

� Inactive Tickers

å To find a ticker in the active list:

1. Choose Ticker and type in the symbol of the ticker you want to find
in the list box at the right.

2. Click OK.  When the Data Manager window reappears, the list in
the list window will display the ticker you specified.
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å To find missing tickers in the active list:

1. Choose Missing Tickers.  This option finds tickers in the list that
are not also in the Master Ticker List.

2. To create a list of all missing tickers, the option box titled Put
results in List must be checked.  The default name for the list is
SEARCH.  To change the name of this list, type a new name in the
text box at the right.  If a list is not created, the results of the search
will be shown in the List window.

3. Click OK.  When the Data Manager window reappears, the list in
the list window will display the search results.

å To find inactive tickers in the active list:

1. Choose Inactive Tickers.  This option finds tickers in the list that
are designated inactive.

2. To create a list of all inactive tickers, the option box titled Put
results in List must be checked.  The default name for the list is
SEARCH.  To change the name of this list, type a new name in the
text box at the right.  If a list is not created, the results of the search
will be shown in the List window.

3. Click OK.  When the Data Manager window reappears, the list in
the list window will display the search results.
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6. Compute Group/Sector Indices function

In order for you to use the group/sector analysis capabilities of AIQ
TradingExpert Pro, you must create group and sector index files.
These index files are created from the stock data in your data base
and the information in your Group/Sector List.  You should have
complete data for all tickers in new groups that are created.  Any gaps
in the data will be reflected in the computed index.

Uses of this function include:

� You can recompute all of the indices in your entire Group/
Sector List or you can selectively recompute a specific group
or sector in your Group/Sector List.

� You can compute a new index for a user created group list.

� If you create a new group or sector, or you add new equities
to a group, and you want to see an analysis at once without
waiting for your next data retrieval, you can use this function
to create the index.

� You can use this function to recompute a group and sector
after you have performed a stock split on an equity within
that group or sector.

How to use Compute Group/Sector Indices

Compute Group/Sector Indices is a function on the sub-menu of
Utilities in Data Manager.  Displayed is the dialog box for the
Compute Group/Sector Indices function.  The dialog box contains
two sections.  Select options from each section according to the
following instructions.

Note
Group and sector indices are
also created, automatically,
during the data retrieval
process.  Once created by
either data retrieval or by
using the Compute Group/
Sector Indices function,
indices are updated after each
data retrieval session.

Compute Group/Sector Indices
dialog box
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S o u r c e

Choose one of these two options:

1. Compute List(s) - Computes indices for any existing list - your
Group/Sector List or any user created list.  Use this option to
compute indices in one list or in multiple lists.  If the selected list is
comprised of more than one level, such as the Group/Sector List, all
group and sector indices within the list will be computed.

å To use this option:

Click the option button and then select one or more lists from the
text box.  To select more than one list, hold down the Ctrl key
while clicking each additional list.

2. Selected Group Symbol(s) - Computes only Group/Sector List
indices.  With this option, you can limit the groups and sectors
computed to only those that you select.

å To use this option:

Click the option button and then select one or more groups and/or
sectors from the text box.  To select more than one group or sector,
hold down the Ctrl key while clicking each additional ticker.

When you select this source option, you have the choice of also
computing associated child symbols, parent symbols, both, or
neither for the selected group or sector.  Make your selections as
follows:

� Compute Child Symbols  (default option)

Checking this option computes only child symbols.  For
example, when you compute the index for a single sector, the
indices for all groups within that sector will also be
computed.  However, the index for the sector�s parent sector
(if any) will not be computed.

� Compute Parent Symbols

Checking this option computes all parent symbols.  For
example, when the data for a single stock has changed, you
can use this option to recompute the affected parent group,
and the indices for all associated sectors will also be
computed.

� Compute both Child and Parent Symbols

By checking both options, both parent and child symbols
will be computed.

Note
When a check mark appears
in the check box of a
command, that command is
�turned on.�   To turn the
command �off,� simply click
the check box to remove the
check mark.
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� Compute neither Child or Parent Symbols

By removing checks from both options, only the selected
group or sector index will be computed.

R a n g e

Choose one of these three options:

1. Update from Last Date of Data (default)

Computes indices only from the last date of data to the present time.
Use this option to compute a new index.

2. Recompute All Dates

Select this option to recompute from the earliest data date for the
selected ticker to the present time.

3. Recompute Range of Dates

Select this option to recompute for a specific time period.  Specify
the first and last dates for the recomputation in the text boxes
provided.

When you have completed all entries, click OK to continue with
computation of indices, or click Cancel to abort.
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7. Set RS Symbols

Setting up the Relative Strength indicators

TradingExpert Pro provides two Relative Strength indicators on
charts, RS Index (Indx) and RS Ticker (Tkr).  Before you can use
these two indicators to track the relative strength of tickers in your
data base, you must first enter RS Symbols for each of the indicators.
There are two methods to set the symbols for the Relative Strength
indicators:

� You can separately enter RS Symbols for each individual ticker.  If
you choose this method, the New Ticker and Edit Ticker dialog
boxes provide text boxes where you can enter or change the RS
Symbols for either indicator.

� You can enter RS Symbols globally (for the Master Ticker List or
for individual lists) with the Set RS Symbols function.

Using the Set RS Symbols function

This function is used to globally set the Relative Strength symbols for
TradingExpert Pro�s two Relative Strength indicators.

å To access Set RS Symbols:

1. Open the Data Manager application.

2. Click the Utilities command on the menu bar.

3. Choose Set RS Symbols from the drop-down menu.

Two options are available.

� Set RS Tickers sets RS Symbols for the RS Ticker indicator

� Set RS Indices sets RS Symbols for the RS Index indicator.

Note
For more information on
using TradingExpert Pro�s
two Relative Strength
indicators, refer to the
Technical Indicators
Reference Manual.

Set RS Symbols submenu
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Set RS Tickers

This option sets the Relative Strength symbols for the RS Ticker
indicator to conform with the relationships defined in a list.  It is
included primarily to provide an easy way to set the Relative Strength
symbols in accord with group/sector relationships.  For all tickers in
the Group/Sector List, RS Symbols are set to their parent tickers (i.e.,
tickers one level higher in the group/sector pyramid structure).

Although its primary function is for setting relationships in a Group/
Sector List, Set RS Tickers is also used for setting relative strength
relationships in any user created list that has a parent/child structure.
For example, in a list of tickers with a group index, the tickers are set
to their parent (group) ticker.

This function may also be used to clear all settings for the RS Ticker
indicator.

Shown is a chart of IBM with IBM�s parent ticker, 3570 (Computer
Systems group), set as the RS Ticker (RS Tkr 3570).  The RS Ticker
indicator is displayed in the lower window, showing the relative
strength of IBM compared to its parent group, Computer Systems.

  Chart of IBM
with RS Tkr3570 (ComputerSystems)
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To set RS Tickers

When you choose Set RS Tickers from the Set RS Symbols sub-menu,
a dialog box is displayed.  Two entries are required.

Set RS Tickers dialog box

Note
If a ticker in a user created
list does not belong to a
parent group, no symbol will
be set for the RS Ticker.

Selected List(s)

Select one or more lists:

This text box displays your Group/Sector List and all of your current
user created lists.  Select a list by clicking on it with your mouse
(click on a selected list to deselect it).  Hold down the Ctrl key to
select multiple lists.

T a s k s

In addition to setting RS Symbols for the selected list, you can, at the
same time, elect to clear all RS Ticker symbols in the Master Ticker
List.  You can also elect to set RS Symbols only for those tickers that
do not currently have RS Symbols.

Select one of these four tasks by clicking the option button:

� Set Relative Strength Relationships (Overwrite Existing
Relationships)
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Note
TradingExpert Pro for
Windows is delivered with
the SPX (S&P 500 Index) as
the default RS Symbol for the
RS Index indicator.
Therefore, when a chart of a
ticker is displayed, RS Indx
SPX will appear on the
Control Panel (see IBM
chart).

This option sets all RS Tickers to parent tickers (for example, all
stocks in a group would have the group ticker as their RS Ticker,
and all groups in a sector would have the sector ticker as their RS
Ticker).  Existing relationships are overwritten.

� Set Relative Strength Relationships (Do Not Overwrite Existing
Relationships)

This option also sets RS Tickers to parent tickers, but only for those
tickers that do not currently have an RS symbol.  In other words, all
existing settings are preserved.

� Clear All RS Tickers in Master Ticker List and Set All Relative
Strength Relationships

This option first clears all settings for the RS Ticker indicator, then
sets the RS Tickers in the specified list(s) to parent tickers.

� Clear All RS Tickers in Master Ticker List

This option clears all RS Symbol settings for the RS Ticker
indicator.  The RS Ticker in the Control Panel of charts will be
displayed with a ? mark (RS Tkr ?).  When a symbol for the RS
Ticker is set, the symbol will replace the ? mark.

Set RS Indices

This function sets the Relative Strength symbols for the RS Index
indicator.  Set RS Indices allows you to globally set RS Symbols to a
user specified market index.

To set RS Indices

When you select Set RS Indices from the Set RS Symbols sub-menu, a
dialog box is displayed.  Four entries are required.

S o u r c e

This entry specifies which tickers will receive RS Index symbols.
That is, when charts are displayed for these tickers, the RS Index will
be set to a specified index ticker.
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Select one of these three options by clicking the option button:

� All tickers - Sets all of the tickers in your data base.

� All tickers in List - Sets all of the tickers in the list(s) selected in
adjacent text box.  The text box displays all of your current lists
including your Group/Sector List.  Select a list by clicking on it
with your mouse (click on a selected list to deselect it).  Hold down
the Ctrl key to select multiple lists.

� Tickers - Sets only those tickers shown in the adjacent text box.
Any number of tickers can be entered here.  Separate tickers by
semicolons (;).  The currently selected ticker or tickers in your
Master Ticker List are initially displayed in this box.

Set RS Index to:

This entry specifies the market index that RS Symbols will be set to.
Select a market index from the text box.  Use the arrows to display 12
different indices.  Choose an index by clicking it with your mouse.

Set Only

This entry limits which tickers will be set regardless of which Source
option is selected.  There are eight types of tickers which can be
designated.  By placing a check in the appropriate check boxes, you
can select all eight types or as few as none.

Set RS Indices dialog box
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Example situations:

� Source specifies All Tickers but you only want to set RS Index
symbols for the stocks in your data base.  By checking Stocks and
unchecking all other types in the Set Only window, the function will
limit the setting of RS Index symbols to just the stocks in your data
base.

� If there is a conflict between Source and the Set Only options
selected (or not selected), the Set Only options will supersede.  For
example, if Source specifies a list which contains only mutual fund
tickers and the mutual fund type is not checked in Set Only, RS
Index symbols will be set regardless of the Source designation.

T a s k

In addition to setting RS Symbols for the selected tickers, you can, at
the same time, elect to clear all RS Index symbols in the Master
Ticker List.  You can also elect to set RS Index symbols only for those
tickers that do not currently have an RS Index symbol and thereby
preserve all existing settings.

Select one of the four task options by clicking the option button:

� Set Relative Strength Relationships (Overwrite Existing
Relationships)

This option sets all RS Index symbols for the specified source to the
selected index.  Existing RS Index symbols are overwritten.

� Set Relative Strength Relationships (Do Not Overwrite Existing
Relationships)

This option sets RS Index symbols only for those tickers that do not
currently have an RS Index symbol.  All existing settings are
preserved.

� Clear All RS Indices in Master Ticker List and Set Relative
Strength Relationships

This option first clears all settings for the RS Index indicator, then
sets all RS Index symbols for the specified source to the selected
index.

� Clear All RS Indices in Master Ticker List

This option clears all settings for the RS Index indicator.  The RS
Index indicator in the Control Panel of charts will be displayed with
a ? mark (RS Indx ?).
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8.  Printing data lists

You can, in Data Manager, print a paper copy of the Master Ticker
List, the Group/Sector List, any user created list, or an Exception
List.  This latter list is a list of all tickers not included in a particular
list.

å To print a list:

1. Open the Data Manager application.

2. If you wish to print your Group/Sector List, any user created list, or
an Exception List, you must first select that list from the Selected
List text box on the menu bar.

� Click the arrow on the right side of the text box to display a
list of your available lists.

� Click on the name of the list that you want to print.

3. Click the Manager command on the menu bar, and select Print
from the drop-down menu.

4. From the Print sub-menu, choose one of the three print options:

� Master Ticker List displays a dialog box with nine type
designations for printing.  Choose any or all of the types by
clicking the check boxes.  Choosing all types prints your
complete Master Ticker List.

� Selected List immediately prints the selected list.

� Exception List immediately prints the selected list.

Note:
If you have not previously
done so, check that your
printer is set up correctly.
Select Print Setup on the
Print sub-menu.  Verify that
the settings are correct and
make any changes if
necessary.

Print sub-menu

Master Ticker List
print designations
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9. File management

A key to working successfully with TradingExpert Pro is astute
management of your data base; that is, knowing when to delete stocks
and other data, how to maintain proper sized price data files, and how
to keep your data clean and free of errors.  All are important for
efficient and effective file management.

Keeping your data clean

TradingExpert Pro provides several functions to help you keep your
data clean and free of errors.  One very helpful function is the
Messages log.

After every update from your data service, messages about the update,
such as data error notes and information on stock splits and mutual
fund distributions are written to a Messages log.  AIQ recommends
that you examine the Messages log frequently and correct all data
errors as soon as possible.  After an update is complete, you should
check the Messages file. By conscientiously maintaining your data on
a daily basis, you can prevent errors from accumulating.  Otherwise,
if ignored for a long time, the situation can get out of hand.  It is the
user�s responsibility to keep the data base up-to-date and free of
errors.

Messages window
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To make it convenient for you to check messages frequently, the
Messages log is easily accessible from the Quick Launch Menu button
on the toolbar of all TradingExpert Pro applications (except Data
Retrieval).  Messages can also be accessed from the TradingExpert
Pro Program Group window.  Simply click on the Messages icon in
either of these places, and accumulated messages from your telephone
updating  sessions are immediately displayed on your screen.  You
can print the messages file by clicking the Print button on the toolbar
of the Messages window.

TradingExpert Pro also provides a data checking function called
Check Ticker Data which can be used to automatically inspect one or
more price/volume data files.  Check Ticker Data writes a list of data
inconsistencies and possible errors to the Messages log.  Use the
Check Ticker Data function to look for data errors in files that you
suspect may have problems.  When viewing a file with this function,
any large errors such as zero�s or far out-of-range prices will be
immediately apparent.

Check Ticker Data can be found on the sub-menu of Utilities in Data
Manager.

Following are some other Data Manager functions that are helpful
for file management.

Manage ticker fi les with Edit  function

An important tool in Data Manager for maintaining your data
properly is the Edit function.  Using Edit, you can view and make
changes to price and volume data for every ticker in your Master
Ticker List.  Edit provides the means to adjust data for stock splits
and mutual fund distributions.  Also, you can change any of the
general data for an individual ticker.

Change status codes to Inactive for tickers of no
i n t e r e s t

A ticker designated Inactive will not be updated through your data
service.  The data file for this ticker remains in your data base,
however, and can be reactivated to retrieve current data by changing
the status code back to Active.  Use the Change Status Codes function
to make tickers inactive.

Delete superfluous data

In this age of mergers and acquisitions, some  stocks disappear from
the market.  When this happens, you should get an error message
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from your data service indicating that the ticker symbol is no longer
recognizable.  It is time to delete that ticker from your data base.

To delete a ticker, use the Delete function found on the sub-menu of
the Ticker command in Data Manager.  This function deletes the
ticker from the Master Ticker List.  Also, the ticker�s price data file is
deleted from your disk.  To delete a group or sector from a list, use
the Delete function from the List sub-menu.  This function removes
the specified group or sector from the list and deletes the price data
file from your data base.

When you request an action that will result in the deletion of data,
TradingExpert Pro warns you that you are about to delete data files
and asks you to confirm before any data is actually deleted.

Maintain proper sized price data files

Each day, as new prices are added to your data files, they continue to
grow until you take the explicit action of reducing them.  To
eliminate old data from your data files, use the Change Start Dates
function.  This function will reduce all your data files or selected data
files

Remember, daily charts will display up to one year of data, and
weekly charts will display up to 4 1/2 years of weekly data.  For valid
Expert Rating signals, you need a minimum of 200 periods (days or
weeks) of  historical data.  Use these figures as guidelines to
determine how much historical data to keep in your files.
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